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Safety Symbols
The following symbols are used in this manual to prevent accidents that may occur as a result of incorrect use of the 
instrument.

Indicates information that contains safety warnings or notes. 
Read the information carefully to ensure safe use.

Indicates a prohibited act.
Never commit such acts.

Indicates an instruction.
Affix to the instruction.

Indicates safety information concerning the laser.
Read the information carefully to ensure safe use.

Official Names for Application Mentioned in This Manual
(Indication in this manual)                                                      (Official name)
Windows, Windows Vista Microsoft ® Windows ® Vista ® Business Operating System
Windows, Windows XP Microsoft ® Windows ® XP ® Professional Operating System
Windows, Windows 7 Microsoft ® Windows ® 7® Professional Operating System

Trademarks
• Microsoft, Windows, Windows 7, Windows Vista and Windows XP are registered trademarks of Microsoft 

Corporation in the United States and other countries.
• Other product names and company names are the registered trademarks or trademarks of their respective 

owners.

Notes on This Manual
• It is strictly prohibited to copy or reproduce any of the content in this manual without the expressed permission of 

KONICA MINOLTA. 
• The contents of this manual are subject to change without notice.
• Every effort has been made in the preparation of this manual to ensure the accuracy of its content. However, 

should you have any questions or find any mistakes, please contact the place of purchase.
• KONICA MINOLTA assumes no responsibility whatsoever for accidents or other consequences arising from the 

use of this software in disregard of the content of this manual.

About This Manual and Related Documents
This manual explains RANGE VIEWER commands in the sequence they appear in the menu bar. RANGE VIEWER 
is 3D scanning software created specifically for KONICA MINOLTA RANGE7/5. 
The following manuals are related to the information contained herein.

Title Description

RANGE VIEWER 
Reference Manual 

Explains the commands selected from menus and buttons as key words 
regarding the various functions of RANGE VIEWER.

RANGE7/RANGE5 
Instruction Manual 

Explains the functions, operating procedures and warnings of the 
RANGE7/5 that acquires 3D profile data of diverse kinds of industrial 
products at high speed and to a high degree of accuracy.

RANGE VIEWER  
Installation guide This sheet explains how to install or uninstall RANGE VIEWER.
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Safety Precautions
When using RANGE VIEWER, observe the following precautions to ensure correct safe use. Also, read this manual 
carefully and keep it in a handy place for future reference.

WARNING 
Failure to observe the indicated information may result in serious injury or even death.

Failure to observe the indicated information may result in fire or electric shock. Before 
using this system, carefully read the manuals provided with the RANGE7/5 and computer 
together with this manual to ensure correct safe use.

Do not look directly into the laser emission window of the RANGE7/5.

Keep lenses, objects with mirror-like surfaces and optical elements out of the 
optical path of the RANGE7/5 laser. These objects can focus the laser beam, 
resulting in damage to eyes, fire and burns. Also, to prevent inadvertent accidents, 
situate works in front of a wall or other structure that shields the laser beam.

Package Contents
RANGE VIEWER Install CD-ROM x 1• 
Installation Guide• 

Software Restrictions
The terms and conditions for using this software are provided in the Software User’s Agreement window that 
appears online during installation. This software may only be installed by agreeing to those terms and conditions.

Notes on Use
This software is application software for Windows Vista, Windows XP or Windows 7. Neither the package nor • 
product includes an OS.
One of these operating systems must be installed in the computer before this software may be installed.• 
Load the CD-ROM into the CD-ROM drive with the correct side up. Keep level and do not force into the slot.• 
Do not dirty or scratch the CD-ROM. Dirt on the recording surface and scratches in the label may cause read • 
errors.
Be careful of sharp temperature changes and condensation.• 
Keep the CD-ROM away from direct sunlight, heaters and other sources of heat.• 
Do not subject the CD-ROM to strong impacts or drop it.• 
Keep water, alcohol, thinner and other chemicals away from the CD-ROM.• 
Turn ON power to the computer to eject the CD-ROM.• 

Notes on Storage
After use, return the CD-ROM to its case and store with care.• 
Keep the CD-ROM away from direct sunlight, heaters and other sources of heat.• 
Do not store the CD-ROM in highly humid environments.• 

Every effort has been made in the preparation of this product. However, should you have any questions or find any 
mistakes, please contact the place of purchase or a customer service center.
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Introduction
RANGE VIEWER is newly developed 3D scanning software capable of controlling RANGE7/5 scanning and 
registering, merging and editing scanned data. It adopts a new GUI that enables seamless scanning and 
editing of scanned data. Moreover, it runs on Windows Vista, Windows XP or Windows 7 and can handle 
large volumes of data.
It is equipped with a navigator for showing operating methods and procedures in a large navigation window, 
making it possible for anyone from skilled engineers to beginners to easily and speedily operate.

Main Functions
Data input  Original format: .rgv (1 shot data set) .rvm (multiple data sets),  
 Marker information: .rmk, .txt
Data output  ASCII, STL, original format: .rgv and .rvm, Marker information: .rmk
Scanning support  Monitored images, preview, AF and AE, scanning and rotational stage control 
Editing Data registration, data merging, point deletion 
Drawing Point shading

Required Operating Environment
OS Windows Vista Business SP2 (64bit), 
 Windows XP Professional x64Edition SP2 (64bit)
 Windows 7 Professional (64bit)
CPU Core2Duo, Xeon or faster
RAM 4GB or more
Display 1280 x 1024 or higher resolution graphics
Graphic board  OpenGL board (It is recommended to use boards tested and proven by KONICA 
 MINOLTA.)
Interface USB 2.0 port

Installation and Uninstallation
Install and uninstall RANGE VIEWER in a computer as explained in the RANGE VIEWER Installation Guide. 

(Added/Changed Functions in Ver.2.0)
1. Compatible with Windows7 Professional 64bit.
2.	 From	the	viewpoint	of	 improvement	 in	operability	and	data	visibility,	 the	GUI	design	was	modified.	3D	

view of the Scanning mode screen was changed from 3 screens to 2 screens. 
3. [Edit marker holes] was added to the editing function. The marker holes became capable of being hole-

filled	by	RANGE	VIEWER.
4. By means of the paired points initial registration, selected data can be moved not just immediately after 

scanning but at other moments.
5. By means of the paired points initial registration, registration can be performed based on the plural 

number of data.
6. Background colors of windows and scanned data color scheme (surface, back side) were changed.  

Linkage	of	scanned	data	and	an	un-shot	part	can	be	identified	easily.
7. Changed the marker display color of 2D view. A marker can be displayed at the time of contour display as 

well.
8. A selected element window is zoomed in while monitoring is being executed. A position during scanning 

became	easy	to	confirm.
9. Rotary movement of a viewing position followed by 3D view provides more intuitive mouse operation.
10. Extensively speeded up the function to select point groups.
11.	Displays	version	of	firmware	for	the	scanning	device	in	[Scanning	Device	Information]	dialog.
12. Automatically deletes groups of very small points at the time of scanning. Editing labor can be saved.
13. Strengthened the data noise deletion function, and improvement was made with the data quality of edge part.
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Command available on the scan window 
(The icon is ghosted if the command is not available.)

Command available on the edit window 
(The icon is ghosted if the command is not available.)

Chapter index

How to use this manual
The User's Guide explains the basic operation flow of RANGE VIEWER. After learning the flow of 

measurement and basic Operating procedures with this manual, use it together with the  Reference Manual.

The screen picture in this document is the display example of Windows 7 in use.

RANGE VIEWER User's Guide

4. Scanning [Scanning by Paired points]
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Operating Procedure

Pr
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1 Set the work.

Set the Scan settings. (“2-4 Scan Settings” 
P.16)
Select [Paired points] under [Initial registration 
metod].

R
eg

is
tra

tio
n

2 Click  [Monitor] button.

The 2D image obtained by monitor imaging 
appears in the monitor window.
This image is updated at a frequency of 
about five times per second.

Monitor button

3 Click  [AE/AF] button.

AF is performed, and the vertical black line 
in the monitor image moves. By looking at 
this image, adjust the work and the position 
and posture of the RANGE7/5 so that the 
area you want to scan is located within the 
monitor window and the vertical black line 
is near the vertical green line indicating the 
center of lens.

AE/AF button
Vertical black line
Vertical green line

4 If the lines are not aligned, change 
the position and posture again, and 
click  [AE/AF] button.

Make sure that the position of the vertical 
black line and the vertical green line 
displayed in the center of the window are 
almost aligned.

AE/AF button

4. Scanning [Scanning by Paired points]
Warning
Do not look directly into the laser emission window. 
Keep lenses, objects with mirror-like surfaces and optical elements out of the optical path. These 
objects can focus the laser beam, resulting in damage to eyes, fire and burns. Also, to prevent 
inadvertent accidents, situate works in front of a wall or other structure that shields the laser beam.

Pr
ev

ie
w

5 Click  [Preview] button.

A preview appears in the 3D window after 
scanning at a speed faster than actual 
scanning.
You can check the state of the image to 
scan by menu button and mouse operation.

Preview button
 Supplement

If you dislike the preview results, see “ 2.4 
Scan settings” (P.16).

6 Check the preview image.

From the  prev iew image,  you  can 
understand the depth and identify dead 
spaces within the scan area, as well as 
the quality of scanning results based on 
surface conditions in advance. You can 
perform the operation for the preview 
image by mouse operation after switching 
the menu button.
To delete the preview image,perform the 
measurement again or click the  [Delete 
last data] button.

Sc
an

ni
ng

7 Click the  [Scan] button.

[Scan] dialog box is displayed, and the 
measurement starts.

Scan button

8 The measurement is completed with 
the set contents.

The measured 3D image is displayed on 
the preview window.
The name of data taken into the element 
list is displayed.

Point For AE/AF, see “2-4 Scan settings” (P.16)

21 22

Chapter index 
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Concept of RANGE VIEWER

Concept of RANGE VIEWER
You can process 3D data by using RANGE VIEWER, the RANGE7/5, and 3D point group processing software 
(third-party application software).

Major features of RANGE VIEWER

SaveEditingMeasurement

You can control the 
RANGE7/5 from RANGE 
VIEWER to obtain 3D 
point group data.

• Paired points
• Rotating stage
• Markers/Markers (Fixed)

You can edit the obtained 
3D point group data using 
RANGE VIEWER to 
produce desired results.

You can also edit the 
data so that it can be 
used by third-party data 
editing software designed 
for inspection and 
reverse-engineering.

• rvm file
• rgv file

• STL file
• ASC file
• IPC export

Export
Read

Import

• rmk file

Marker coordinate
Export

Third-party 
application software

 Provides various editing functions from RANGE7/5 
scanning control to data registration and integration.
 Adopted GUI that allows users to seamlessly perform 
scanning and scanned data editing operations.

 Compatible with Windows Vista, Windows XP and 
Windows 7 64bit, and a large volume of data can be 
managed.
 Equipped with a navigation function that displays operation 
methods and procedures on a navigation window.
 Allows scanning of black objects with a low reflectivity 
using the Dark Surface mode.
 Since the 3D coordinate values of the markers can 
be read into the file by registration of newly added 
markers (fixed), errors do not accumulate with 
repeated registration.

RANGE7/5

Work 

computer

Selected element window
(Preview window)

All elements window

[Scanning Mode] screen
(Push one button to switch to [Edit 
Mode] screen)

AC100V

USB cable

AC adapter

Monitor image
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Flow of Measurement

4 5 6

Help Install RANGE VIEWER.

Set up the RANGE7/5 and the computer correctly according to the RANGE7/5 Instruction 
Manual.

Instruction 
Manual

1 Start RANGE VIEWER.

About 
RANGE 
VIEWER

2 Set the work.                        *  Tick the Dark Surface mode checkbox  if the work to be scanned is black  
(has low reflectivity). 

Paired points Rotating stage
The work that covers a size of FOV 
(Field of View) and requires data of 
the full perimeter of the work.
* Optional rotating stage is 

required.

Markers/Markers (Fixed)

11 3
Odd-shaped work Work with flat surface

10

Calibration
Affix markers for the type 
of lens used onto the work.

See the 
3D image

Monitor

Autofocus by AE/AF Autofocus by Spot AF Set the focus and 
exposure manually.

Scan settings Scan settings Scan settings

Preview

Scans the calibration 
chart.

Performs paired points 
registration and measures 
data of the full perimeter 
of the work.

Performs automatic registration 
using the rotating stage.
(Scans the full perimeter of the 
work automatically.)

Registration is performed 
automatically with 
markers/markers (fixed).

9  

8 Save Export

 

Flow of Measurement (The numbers 1 to 11 represent the chapter number.)

7
Registration of 
the elements.

Deletes unnecessary points. Edit marker holes
(Only at the time of 
scanning by marker)

Merges 3D data.

Measure

Edit
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1. RANGE VIEWER Startup
When you start RANGE VIEWER, the software will attempt to recognize the RANGE7/5. When the device 
is recognized, measurement becomes possible. Therefore, check that the RANGE7/5 is connected correctly 
to the computer before starting RANGE VIEWER. However, when only editing will be performed, it is not 
necessary to have the RANGE7/5 connected to the computer.

1.1 Startup
Operating Procedure

1 From the Windows start menu, open 
[All Programs] – [KONICA MINOLTA] –
[RANGE VIEWER], and select [RANGE 
VIEWER Ver.*.*].
The opening window appears for 3 sec as RANGE 
VIEWER starts up.

 Supplement
•	 Windows open at the maximum size when the 

application starts up.
•	 A warning appears if the display resolution is too 

low.
•	 You can also start directly by double clicking a 

RANGE VIEWER data file. (The splash screen 
is not displayed when you start directly from a 
file.)

2 Scanning status is shown in the status 
bar.

Status bar

 Sensor icon

 Sensor icon with warning mark

 Ghosted sensor icon

•	 Whether properly connected to the instrument or 
not.
•	 Scanning lens
•	 A warning appears until instrument temperature 

stabilizes.
•	 A sensor icon appears when connection has 

been achieved.
•	 A warning mark appears over the sensor icon 

until temperature stabilizes.
•	 A warning mark appears over the sensor icon 

if the temperature changes (approx. ±1.5 ˚C) 
from the last calibrated temperature. 
•	 The sensor icon is ghosted if the instrument is 

not connected.

 Supplement
When scanning is done while a warning mark is 
ON, a warning dialog is displayed before starting 
to scan. 
To avoid the display of the warning dialog, please  
calibrate after warming-up under uniformity 
temperature environment without a temperature 
change. Then, measure under the same temperature 
environment.
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1.2 Exit

Operating Procedure

1 Select [Exit] from the [File] menu.

RANGE VIEWER quits.

The message to confirm saving data will appear, 
if there are any elements that were changed after 
scanning or the last time that data was saved.

When you click the [Yes] button, the measured ••
and edited data are saved and the RANGE 
VIEWER is exited.
When you click the [No] button, the RANGE ••
VIEWER is exited without the measured and 
edited data being saved.

  Supplement
“Element” is the 3D data unit used by RANGE 
VIEWER.
Normally, one element is generated and edited 
from scanning.
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 Common GUI
A Title bar Displays the name of the software.
B Menu bar Contains various functions for operating RANGE VIEWER. Clicking a header 

opens a drop-down menu from which functions can be selected.
C Menu buttons Buttons for executing often-used functions of the menu bar.

Viewpoint rotate
Viewpoint move
Zoom
Zoom selected area
Fit to window
Show points
Show shaded points

D Scan tab Switches to the scanning mode for controlling the RANGE7/5 and acquiring 3D data.
Screen switches to [scan window] screen by clicking. 

E Edit tab Switches to the editing mode for viewing and editing acquired 3D data using 
editing tools.
Screen switches to [editing window] screen by clicking.  

F Status bar Displays the connection status of the RANGE7/5 and information such as  
operation and procedure hints.

G Navigation 
message 

Displays hints and messages on upcoming operations according to selected 
operations and status.

H Element list List of registered elements. Elements can be selected/unselected as well as 
shown/hidden by checkbox operation.
*The element list for the "scan window" is different from that of the "editing 

window", and only a single element can be selected in the "scan window" 
element list. 

*Selected elements only can be displayed by selecting the elements while 
pressing the Alt key.

1.3 Screen composition of [scan window] screen
RANGE VIEWER has a “scan window” for scanning and an “editing window” for editing. These windows are 
opened by clicking the scan and edit tabs on the left side of the window.

B

D

F

E

4
5
6

3
2

1

A

C

H

G

7

9

8
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 Scan Window GUI

1 Scan settings The current settings of the scan parameters are displayed. Scan parameters can 
be changed. If the data reduction ratio setting is changed, data can be reducted 
when they are scanned. 

2 Monitor button Clicking projects the FOV (Field Of View) indicator on the work and displays a 
2D image of the work in the monitor window.

3 AE/AF buttons Starts AE/AF, AF only or AE only based on scan settings.
4 Spot AF button When you press the point AF button and then specify the focus point on the 

monitor screen by clicking on the point you want to focus on, the RANGE7 
focuses automatically on the specified point.

5 Preview button The object is prescanned.
6 Scan button Scans the work based on scan settings.
7 Monitor window Perform monitoring of the object by the monitor button, and display the 

zoomed out monitor screen. You can check and adjust the FOV (field of view = 
measurement area). 
The green vertical line indicates the center of the lens, while the black vertical 
line is for adjusting scanning distance and focus.

Color bar
Delete last data button

Show color bar button 
Show contours button
Show monochrome view button

  Displays the scanned data in a monochrome view.

  Displays scanned data in differing colors by distance.
   Displays the color bar used to display scanned data 

in differing colors by distance. 
  Deletes previews and the last scanned element.

Unnecessary markers 
in scanning with marker 
points are deleted 
directly from the 
monitor window.

Set registration 
points button

8 Selected element 
window  
(Preview window)

Displays only the data selected from the element list. Scanned objects pre-scanned 
by the preview button or the data scanned by the scanning button are selected and 
displayed in this screen. The paired points registration is done by the 3D image on 
this screen and the 3D image on the All elements window.
When the scanned data are selected, the letters on the upper left indicate [Selected 
element] and if previewed data are selected, then the display becomes [Preview].

9 All elements 
window

This is the window to confirm scanned data as 3D image. Shows setting of 
Display/Non-Display of the element list, and elements selected from the element 
list are shown in selected colors while the rest are in a non-selected color. Paired 
points are performed in 3D image of this screen and selected (preview) screen 
of 3D image.

Point Only one RANGE VIEWER can be running at a time.
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 Common GUI

A Title bar Displays the name of the software.
B Menu bar Contains various functions for operating RANGE VIEWER. Clicking a header 

opens a drop-down menu from which functions can be selected.
C Menu buttons Buttons for executing often-used functions of the menu bar.

Viewpoint rotate
Viewpoint move
Zoom
Zoom selected area
Fit to window
Show points
Show shaded points

D Scan tab Switches to the scanning mode for controlling the RANGE7/5 and acquiring 3D 
data. Click to switch the screen to the "Measurement Screen".

E Edit tab Switches to the editing mode for viewing and editing acquired 3D data using 
editing tools. Click to switch the screen to the "Edit Screen".

F Status bar Displays the connection status of the RANGE7/5 and information such as  
operation and procedure hints.

G Navigation 
message 

Displays hints and messages on upcoming operations according to selected 
operations and status.

H Element list List of registered elements. Elements can be selected/unselected as well as 
shown/hidden by checkbox operation. 

1.4 Screen composition of [editing window] screen
RANGE VIEWER has a “scan window” for scanning and an “editing window” for editing. These windows are 
opened by clicking the scan and edit tabs on the left side of the window.

H

3

E

F

1

D

A

C
B

G 2
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Point This window is for editing scanned data. Preview data cannot be edited. Also, reference markers are 
not shown.

 Editing Window GUI

1 Editing tool buttons For editing 3D images. The selected button is highlighted.

Rectangle select 
Draws a rectangular area for selecting/unselecting points.

Bezier select 
Draws a Bezier curve for selecting/unselecting points.

Point selection invert 
Inverts points between selected/unselected.

Element boundary point select 
Selects only boundary points of elements.

Front point select 
Enables selecting points having the normal facing towards the camera.

Point delete 
Deletes the paired points.

Undo 
This cancels the last edit operation and returns the software to the 
state just before that operation.

Redo  
This redoes the edit operation canceled with the "Undo" button.

Element registration
Registers the selected elements.   

Edit marker holes
Edit data of the market part.

Element merge 
Merges the selected elements.

Open 
Opens files.

Save 
Saves files.

Export 
Exports elements to other applications.

2 3D view Displays a 3D view of works as they are edited.

3 Element delete button To delete an element, select the element to delete from the element list and 
then click the [Delete Element] button.
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2. Setting Work
Warning
Do not look directly into the laser emission window. 
Keep lenses, objects with mirror-like surfaces and optical elements out of the optical path. These 
objects can focus the laser beam, resulting in damage to eyes, fire and burns. Also, to prevent 
inadvertent accidents, situate works in front of a wall or other structure that shields the laser beam.

2.1 Distance to and Size of Work
To position the work appropriately in relation to the RANGE7/5, adjust the position and posture of the work and 
RANGE7/5. Make the adjustment while watching the work in the monitor window.

By clicking the [Monitor] button, check the work on the 
monitor window.

Distance to and size of the work (Unit: mm)

Lens TELE WIDE

Distance 450 800 450 800

X × Y 79 × 99 141 × 176 150 × 188 267 × 334

Z 54 97 109 194

For RANGE5, please refer to the WIDE lens data.

Distance to and size of the work in the case of
multi focusing (Unit: mm)

Lens TELE WIDE

Distance 462 781 475 766

X × Y 81 × 102 138 × 172 159 × 199 256 × 320

Z 54 97 109 194

For RANGE5, please refer to the WIDE lens data.

Point Select the lens according to the size of the work. Although accuracy improves when you activate the Multi focus 
mode, note that the distance to and size of the work differ.

Memo

Memo

Distance 
450mm to 800mm

RANGE7/5

Work

Y

X Z

• The origin is set at the sensor position which is 
approximately 120 mm behind the center of the 
lens surface. Therefore, the Z dimension has an 
offset of around 120 mm applied. 

Light-receiving lens 
RANGE7: TELE/WIDE replaceable
RANGE5: Lens not replaceable( )
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2.2 FOV indicator
A FOV (field of view) indicator projects the below pattern of light on the work to make it easier to identify the 
scan area. 
The FOV indicator is synchronized with motor operation to continuously project the light. (Note: FOV indicator 
updates slow while RANGE VIEWER windows are being operated.)

The estimated scan area is irradiated in synch with 
motor operation.

2.3 Multi focus
In the Multi focus mode, scanning is performed twice by changing the focal point.
When the Multi focus mode is active, the data of the area closer to the focal point is selected for calculation. 
Depending on the work, the effects may differ. However, when you want to obtain results with less data noise, 
set Multi focus to "Enable". Compared to when Multi focus is set to "Disable", it takes more time to display the 
results.
 

                                                                      Z             
First

   Second                                  Z　　　
                              Scan area 

    Multi focus disabled                                    Multi focus enabled

Multi focus image 

Multi focus is enabled and disabled from the Scan Settings dialog box.
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2.4 Scan Settings
AE (automatic exposure) and AF (autofocus)
AE (automatic exposure) and AF (autofocus) can be used in order to maximise scanning accuracy. AE/AF 
configuration and AF method can be changed according to the shape of the work to be scanned and scanning 
environment (brightness). 

Number of Scans
Setting the number of scans to be performed per shot can help you obtain 3D data, for example, the greater 
contrast can be got. 

Dark Surface Mode
The Dark Surface mode can be used to improve the accuracy when scanning a black work with a low reflectivity. 
[Exposure] Ticking the Dark Surface mode checkbox  automatically moves the exposure slider to maximum. 
At the same time, the number of scans to be performed increases by 1 from the preset value, which enables 
scanning of black objects.

 Buttons to be executed from the Scan window  The "Measurement Setting" dialog is displayed 
when "Settings" is selected from the "Measurement" 
menu.

[AE/AF configuration]

[AE/AF configuration] AE/AF button Spot AF button

[AE and AF] Because both AE and AF are performed, 
the distance to the work and exposure are 
automatically measured.

Both AE and AF are performed for the points 
selected in the monitor window.

[AE only] The exposure is automatically calculated. Only AE (automatic exposure) is performed 
for the points selected in the monitor 
window.

[AF only] The distance to the work is automatically 
measured and the instrument focuses on 
the work.

Only AF (auto focusing) is performed for the 
points selected in the monitor window.

[Scan settings] button

Set [Number of scans]

Select [AE/AF configuration].

Select either [AE and AF], [AE only], or [AF only].

Select [Multi focus]. Select [Disable] or [Enable].

Set the exposure 

Dark Surface mode checkbox

Using the AE function in Dark Surface mode will result in the exposure level being set so that bright areas of 
the work are scanned. 
In order to scan a black work, you are advised to set the scan setting to "AF only" using the scan settings 
dialog, so that the AE function is switched off.
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Example of adjusting the focus and exposure by Spot AF or manually
When AE and AF do not produce good results, perform the operation shown below.

At times like this Operation example

When AF makes the area to be measured 
blurred or causes the focus to deviate from the 
scan area

-
Adjust the focus by the  [Spot AF] 
button or manually.

When there are two works to be measured of 
almost the same size, with one closer to the 
instrument than the other

Adjust the focus by the  [Spot AF] 
button or manually.

Work with a fence-like structure in front Adjust the focus by the  [Spot AF] 
button or manually.

When scanning an extremely bright object
-

Manually adjust the exposure to 
around 0%.

When scanning an extremely dark object
-

Manually adjust the exposure to 
around 100%.

Data reduction ratio
The scanned data are reducted evenly in both X and 
Y directions at the reduction ratio set in the scan 
settings mode.
The following four items namely, 1/1, 1/4, 1/9 and 
1/16 can be selected.
Note: Since the number of data in the original 

element is deleted for scanning, the data 
reduction ratio cannot be changed later.
To delete 1/4, do not delete data ends evenly 
and leave data size as much as possible. 

Number of Scans
The number of measurements can be set from 1 to 
5 times. Higher-accuracy 3D data can be obtained 
by increasing the number of measurements. If the 
preview results are not acceptable, increase the 
number of measurements.

Point To obtain better 3D data, adjust room brightness, AE/AF settings, or number of measurements.

Preview example:
1 measurement

Preview example:
3 measurements



3. Selecting Registration Mode

18

3. Selecting Registration Mode
3.1 Registration Mode
There are three methods for scanning work: [Paired points], [Rotating stage] and [Marker].
Each mode has the following features:

[Initial registration 
method] Description Advantage Other

Paired points Per f o rms  reg i s t r a t i on  by 
interpolating the corresponding 
points of  two scanned 3D 
images  when  y ou  se lec t 
corresponding points with click 
the left mouse button.

Because special equipment and 
markers are not needed, you 
can easily perform scanning. -

Rotating stage With the work placed on a 
rotating stage, registration is 
performed automatically.

Simple calibration of the axis of 
rotation is required. Automatic 
registration is possible.

The applicable controllers 
for the rotating stage are the 
SHOT-602* and SHOT-202.

Marker With the markers affixed to 
the work, markers overlapping 
between measured shots are 
registered.

Because maker information 
makes automatic registration 
more accurate than manually 
selecting points, operability 
improves.

Set the marker size according 
to the lens in use: small (for 
TELE lens) and large (for WIDE 
lens).

Marker(Fixed) Markers are affixed to the work 
and the file containing the 3D 
coordinate values of the affixed 
markers is read in. 
Marker registration is performed 
b y  t h e  c o r r e s p o n d e n c e 
relationship between the markers 
in the scanned shots and those in 
the read file.

The 3D coordinate values of the 
markers are given in the file. 
Accordingly, errors do not 
accumulate with repeated 
registration compared to the 
normal marker registration.

Set the marker size according 
to the lens currently used. 
Small (for TELE lens), Large (for 
WIDE lens).
When scanning with markers 
(fixed), select [Marker] from 
the init ial registration and 
check [Not adding new ref.]. 
Determine the 3D coordinate 
values of each marker by 
means of photogrammetry etc. 
before scanning and then save 
it in the file. 
To record the 3D coordinate 
values of markers, rmk and txt 
files can be used. 
The markers scanned during 
scanning with markers (fixed) 
are not added to the reference 
markers.

* Available only in Japan
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3.2 Selecting from [Scan settings] Dialog Box
Select the method of registration from the [Initial registration method] list box in the [Scan settings] dialog box.

[Initial registration method] list box

3.3 Scanning Flow by Registration Mode
* All the examples below are based on four scan shots with the work being rotated by 90˚ each time.

Paired points First shot Second shot Third shot Fourth shot

Data from the second shot 
is merged with data from 
the first shot by paired 
points registration.

Data from the third shot 
is merged with data from 
the second shot by paired 
points registration.

Data from the fourth shot 
is merged with data from 
the third shot by paired 
points registration.

Rotating stage First automatic shot Second automatic shot Third automatic shot Fourth automatic shot

With the rotating stage set to rotate by 60˚ or 90˚ each time, scanned data is automatically merged to 
produce 3D data. Calibration of the axis of rotation is required.

1 2 2 3 3 4 4 1

RANGE7/5
Work

1 2 2 3 3 4 4 1

RANGE7/5

Work

Rotating stage
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Marker/Marker(Fixed) First shot Second shot Third shot Fourth shot

Delete unnecessary 
markers.

Data is automatically 
merged based on the 
position information of 
the markers.
Delete unnecessary 
markers.

Data is automatically 
merged based on the 
position information of 
the markers.
Delete unnecessary 
markers.

Data is automatically 
merged based on the 
position information of 
the markers.

3.4 How to Affix Markers
By affixing the markers to the work, you can register markers 
overlapping between scan shots. *1

Affix the large or small markers to the work according to the TELE 
or WIDE lens mounted on the RANGE7/5: [Small (for TELE lenses), 
large (for WIDE lens)].
Affix the markers at intervals that enable five to ten markers to be 
displayed in the monitor window during scanning.
Perform scanning so that three or more markers (preferably five 
or more markers) can be commonly identified between the current 
scanned element and the next element.*2 The recognized markers 
are shot and saved as reference markers, but misidentified markers 
need to be deleted. However, because the markers recognized 
in the preview will be automatically deleted in the next preview or 
measurement, they need not to be deleted whether or not they have 
been misidentified.

Examples of markers

1 2 2 3 3 4 4 1

RANGE7/5

Work

Affix markers of a size 
corresponding to the 
lens to the work.

*1. Before scanning is performed with markers (fixed), registration is performed by automatically distinguishing 
the reference markers read in from an rmk file or a txt file.

*2. During scanning with markers (fixed), it is not required to keep overlap on the previous scan.

* Only [Large (for WIDE lens)] 
can be used for RANGE5.
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Operating Procedure
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1 Set the work.

Set the Scan settings. (“2-4 Scan Settings” 
P.16)
Select [Paired points] under [Initial registration 
metod].
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2 Click  [Monitor] button.

The 2D image obtained by monitor imaging 
appears in the monitor window.
This image is updated at a frequency of 
about five times per second.

Monitor button

3 Click  [AE/AF] button.

AF is performed, and the vertical black line 
in the monitor image moves. By looking at 
this image, adjust the work and the position 
and posture of the RANGE7/5 so that the 
area you want to scan is located within the 
monitor window and the vertical black line 
is near the vertical green line indicating the 
center of lens.

AE/AF button
Vertical black line
Vertical green line

4 If the lines are not aligned, change 
the position and posture again, and 
click  [AE/AF] button.

Make sure that the position of the vertical 
black line and the vertical green line 
displayed in the center of the window are 
almost aligned.

AE/AF button

4. Scanning [Scanning by Paired points]
Warning
Do not look directly into the laser emission window. 
Keep lenses, objects with mirror-like surfaces and optical elements out of the optical path. These 
objects can focus the laser beam, resulting in damage to eyes, fire and burns. Also, to prevent 
inadvertent accidents, situate works in front of a wall or other structure that shields the laser beam.
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5 Click  [Preview] button.

A preview appears in the 3D window after 
scanning at a speed faster than actual 
scanning.
You can check the state of the image to 
scan by menu button and mouse operation.

Preview button
 Supplement

If you dislike the preview results, see “ 2.4 
Scan settings” (P.16).

6 Check the preview image.

From the  prev iew image,  you  can 
understand the depth and identify dead 
spaces within the scan area, as well as 
the quality of scanning results based on 
surface conditions in advance. You can 
perform the operation for the preview 
image by mouse operation after switching 
the menu button.
To delete the preview image,perform the 
measurement again or click the  [Delete 
last data] button.

Sc
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ng

7 Click the  [Scan] button.

[Scan] dialog box is displayed, and the 
measurement starts.

Scan button

8 The measurement is completed with 
the set contents.

The measured 3D image is displayed on 
the Selected element window.
The name of data taken into the element 
list is displayed.

Point For AE/AF, see “2-4 Scan settings” (P.16)
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9 After rotating the work to a different 
angle, adjust the measurement 
position by monitoring. 
In the same way as 2  to 6  , adjust the 
position.

10 Click  [Scan] button.

[Scan] dialog box is displayed, and the next 
measurement starts.

Scan button

11 The scanning is completed with the 
set contents.

The image measured in the previous 
measurement is displayed on the window 
for the element already scanned, and the 
imaged scanned this time is displayed on 
the preview window.
The name of data taken into the element 
list is displayed.
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12 Click  [Set registration points] button.

The icon changes to  , completing 
the preparation for the selection of the 
corresponding points.
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13 Click the corresponding positions in 
turn.

Perform the registration by designating the 
corresponding positions between the latest 
measured data (left) and any measured 
element (right). Click the corresponding 
positions alternatively on the left and right 
images.

14 When the selection of corresponding 
points  is  completed,  per form the 
registration of the corresponding points.
When you have clicked one or more 
pairs of corresponding positions, you can 
perform the registration by selecting [Done] 
on the popup menu that opens by clicking 
the mouse right button.
When the positions do not correspond, add 
a pair of corresponding points and perform 
the registration again.
Note: Addition of corresponding points 

can be temporarily interrupted 
by selecting interruption from the 
popup menu. To start again, select 
interruption from the popup menu 
again. In addition, interruption and 
restarting can be done by pressing 
the [Space] key.
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15 Continue and repeat scanning from 
different directions.

In the same way as 9  to 14  , measure 
the data at all the angles by repeating 
the adjustment of measurement position, 
measurement, and registration.

The third scanned data

2 data already registered by 14

16  Click [Paired Points Registration]  
button.

The icon becomes , and corresponding 
points can be selected.

Click corresponding positions of the data 
displayed on the Selected element window 
and All elements window, then register. 
At  this stage, paired points can be 
performed to all the plural number of data 
displayed on the All elements window.
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17 When clicking more than one pair in 
corresponding positions, registration 
is executed by selecting [Execution] in 
the pop-up menu provided by the right 
mouse click.

Condition where registration is executed

Scanned data finished with registration 
are automatically displayed in the scanned 
window.

18 The data which was registered once can 
be registered again by selecting them in 
the element list. 
Displays data selected from the element 
list are displayed in the Selected element 
window.

19 By clicking  [Paired Points Registration] 
in this condition, registration can be done 
again for the data [Data-1] which was 
registered once.

Check is turned off so as not 
to display data in the All 
elements window automatically 
while registration.

Data scanned in review

Data moved by registration

Start paired points 
registration

Note: Data obtained by preview cannot be 
used as the bases for registration 
even though they are displayed on 
the All elements window.

selected data itself is not used as 
bases of registration.

Therefore, these data automatically 
become [Non-display] to avoid 
displaying them on the All elements 
window (to disable cl icking of 
corresponding points) during the 
work of paired points.

Sa
ve

20 Select [Save as] from [File] menu.

Save the registered data.
Registered data can be saved by merging 
into one. (“7.4 Merging” P.40)
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5. Scanning [Scanning by Rotating stage]
 

Warning
Do not look directly into the laser emission window. 

Keep lenses, objects with mirror-like surfaces and optical elements out of the optical path. These 
objects can focus the laser beam, resulting in damage to eyes, fire and burns. Also, to prevent 
inadvertent accidents, situate works in front of a wall or other structure that shields the laser beam.

5.1 Flow of Measurerment
The procedure for scanning 3D data using a rotating stage is as follows.

1 Select the registration mode on the Scan 
settings window.

Initial registration method

Stage settings

2  Scan the calibration chart.

Scanning the calibration chart automatically saves 
the axis of rotation in the computer. First, set 
the work on the rotating stage and monitor it to 
confirm the position is within the scanning range, 
and then set the calibration chart on the stage.

3 Set the work on the rotating stage and 
scan it.

Start without using existing scanned data. Set the 
work on the rotating stage with the axis of rotation 
information of step 2  viable (without altering the 
positional relationship between the rotating stage 
and the RANGE7/5 after scanning the calibration 
chart) and scan the work.
Position the rotating stage at each of the set 
angles using the axis of rotation information. In full 
auto scanning, the entire perimeter of the work is 
scanned automatically. For works with complicated 
profiles, it is a good idea to use free step angles 
and monitor the work’s position after each rotation 
and scan.

 

Calibration chart

Elements scanned 
using axis of rotation 
information of step 
2

Acquire axis of rotation information.

Scan entire perimeter using axis of rotation information.
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4 Once having scanned the full perimeter, 
scan the work from a different angle to 
complete the 3D data.
Scanning from a single angle does not complete 
the 3D data as some areas may not have been 
seen. By moving the RANGE7/5 and scanning 
the work from a different angle, points in the first 
element scanned from the new angle can be 
selected from elements captured just before from 
scanning with the rotating stage. This allows you to 
scan with the RANGE7/5 in a different position but 
using the same axis of rotation information.

For details, see “Method 1” in “B. Initial Registration with 
Use of a Rotating Stage, 4.5 Measure” on p. 63 of the 
Reference Manual.

5 If you want to move the work, scan the 
calibration anew.

This present method does not work if the work is 
moved to scan unseen areas. New axis of rotation 
information is needed. In such case, rescan the 
calibration chart.

Scan data anew with the rotating stage at a 0˚ angle 
and select points to interpolate to the element 
scanned in step 2  at a 0˚ angle.

For details, see “Method 2: “B. Initial Registration with 
Use of a Rotating Stage, 4.5 Measure” on p. 64 of the 
Reference Manual.

Select corresponding points from 2 elements.

Scan entire perimeter using axis of rotation information.

Acquire new axis of rotation information.

Elements scanned 
using axis or rotation 
information of step 
2

F i r s t  e l e m e n t 
scanned in step 5

Select corresponding points from 2 elements.

Scan entire perimeter using axis of rotation information.

Elements scanned 
using axis or rotation 
information of step 
2

F i r s t  e l e m e n t 
scanned in step 4
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Operating Procedure

5.2 Scanning by Rotating Stage
The following example of scanning with a rotating stage scans the calibration chart first and then scans the work at 
90˚ steps based on the acquired axis of rotation information. For a more detailed explanation, see “B. Merging 
with Use of a Rotating Stage” in “Scan Settings” on p. 56 of the Reference Manual.
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1 Click   [Scan settings] button 
to open the Scan Settings dialog box, 
and select [Rotating stage]] under [Initial 
registration method].

Calibration chart

Project  holes.

Rotating stage

This operation activates the [Stage] group 
of settings.

2 Set the communication port for the 
controller of the rotating stage.
The controller can be selected between 
[SHOT-602] and [SHOT-202] from the 
[Model] list box in the [Stage] group of 
settings. Select the controller connected to 
the computer.
Select a communication port to connect 
the controller from the [Port] list box in the 
[Stage] group of settings.

3 Click the [OK] button.

The rotating stage is initialized.

After the rotating stage has been 
recognized and initialized, one of the 
following messages appears.
“Cannot find the corresponding axis of 
rotation data.”
“Conditions differ from when the chart was 
scanned.”
“Axis of rotation data has been loaded.”
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4 Set the calibration chart on the 
rotating stage and click   
[Monitor] button.
Position and posture the instrument and 
the rotating stage so that the calibration 
chart appears in the monitor window as 
shown at right.

( N o t e :  P r i o r  t o 
cal ibrat ion,  i f  the 
rotating stage is not 
at the first angle (0˚), 
move the [Rotation 
Angle] slider to 0˚ to 
return the stage to 
the 0˚ angle.)
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Point For AE/AF, see “2.4 Scan settings” (P. 16)
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5 Click the  [AE/AF] button to 
adjust the stand-off distance and 
exposure.
Adjustments are made as determined by 
the [AE/AF configuration] setting on the 
Scan Settings dialog box. 

6 Click  [Preview] button.

Check that the distance image of the 
calibration chart in the preview window 
looks like the good example at right. If it 
looks like the bad example, return to step 
4 .

Good example      Bad example

 
 

7 Click  [Stage calibrate] button.

When clicked, a message appears asking, 
“Ready to initialize stage and scan chart?”
Clicking the [Yes] button rotates the stage 
to the first angle.

8 A message appears asking, “Scan 
chart image?”

Clicking the [OK] button starts calibration 
chart scanning.

9 The calibration chart is scanned.

When scanning has been completed, 
a message appears asking, “Use this 
image?”

Clicking the [Yes] button calculates 
the axis of rotation data and saves it 
as a file. The saved data is used the 
next time registration is done using 
the rotating stage.

(Note: When using the rotating stage by setting RANGE7/5 vertically, place it in the physical relationship 
where the acceptance lens is above the rotating stage, and the laser projection window is below the 
rotating stage. 
Setting the acceptance lens below can obtain counter-rotating data in some cases.)

Stage calibrate button
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10 Remove the calibration chart and 
set the work on the rotating stage.

Work    

11 Set the step angle. This explanation 
sets step angle to 90˚.

Rotating stage

Select “90˚” from the [Step angle] list box.

12 Click   [Monitor] button.

The image obtained from monitoring 
appears as a 2D image in the monitor 
window.

Monitor button

13 Click  [AE/AF] button.

AF is executed and the vertical black line 
moves across the monitored image.

AE/AF button

Vertical black line

Vertical green line for 
indicating lens center
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14 Click  [Scan] button.

The work is scanned at the current angle (0˚) 
and registration results appear in the 3D 
view window. After scanning, the rotating 
stage rotates to the next angle (90˚).

15 Click  [Scan] button and, if 
necessary,  [AE/AF] button.
The work is scanned at the current angle 
(90˚) and registration results appear in 
the 3D view window. After scanning, the 
rotating stage rotates to the next angle 
(180˚).

16 Click   [Scan] button and, if 
necessary,  [AE/AF] button.
The work is scanned at the current angle 
(180˚) and registration results appear in 
the 3D view window. After scanning, the 
rotating stage rotates to the next angle 
(270˚).

17 Click  [Scan] button and, if 
necessary,   [AE/AF] button.
The work is scanned at the current angle 
(270˚) and registration results appear in 
the 3D view window. When data has been 
obtained for the full perimeter, the rotating 
stage returns to 0˚.
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18 Select [Save As] from the [File] menu.

The merged data is saved.
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1 Set the work.

Affix the markers to the work.
(See “3.4 How to Affix Markers” on P. 20)
Set the Scan settings. (See “2.4 Scan 
Settings” on P. 16)
When using [markers (fixed)], check [Not 
adding new ref.], click the [Open ref.] 
button, and read the reference markers out 
of the file.  
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2 Click  [Monitor] button.

The 2D image obtained by monitor imaging 
appears the monitor window.
This image is updated at a frequency of 
about five times per second.

Monitor button

3 Click  [AE/AF] button.

AF is performed, and the vertical black line 
on the monitor image moves. By looking 
at this image, adjust the work, and the 
position and posture of RANGE7/5 so that 
the area you want to scan is located within 
the monitor window and the vertical black 
line is near the vertical green line indicating 
the center of lens.

AE/AF  button
Vertical black line

Vertical greenl line

4 When lines are not aligned, change 
the position and posture again, and 
click the  [AE/AF] button.

Make sure that the position of the vertical 
black line and the vertical green line 
displayed in the center of the window are 
almost aligned.

AE/AF button

6. Scanning [Scanning by Markers/Markers (Fixed)]
Warning
Do not look directly into the laser emission window. 
Keep lenses, objects with mirror-like surfaces and optical elements out of the optical path. These 
objects can focus the laser beam, resulting in damage to eyes, fire and burns. Also, to prevent 
inadvertent accidents, situate works in front of a wall or other structure that shields the laser beam.

If there is a file containing 3D coordinates of markers that has been determined in advance by means of by photogrammetry 
etc, perform initial registration with "markers (fixed)".
The markers scanned during scanning with markers (fixed) are not added to the reference markers.

Operating Procedure
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5 Click  [Preview] button.

The preview appears in the 3D window 
after scanning at a speed faster than actual 
scanning.
You can check the condition of the image to 
scan by menu button and mouse operation.

Preview button

6 Check the preview image.

From the  prev iew image,  you  can 
understand the depth and identify dead 
spaces within the scan area, as well as 
the quality of scanning results based on 
surface conditions in advance. To operate 
each item on the preview image, switch the 
menu button and operate the mouse.
To delete the preview image, perform the 
measurement again or click the  [Delete 
last data] button.
Regarding the preview data for  the 
second shot and afterwards, you can 
check whether or not they have been 
automatically registered in the 3D view.
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7 Click  [Scan] button.

The [Scan] dialog box appears and 
scanning starts.

Scan button

8 Scanning is completed as per 
settings.

Scanned 3D image is displayed on the 
selected element window.
The name of captured element appears in 
the element list.

Point For AE/AF, see “2.4 Scan Settings” (P.16)
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9 When scanning is complete, delete 
unnecessary marker information 
from the monitor window.
You can specify a range and select markers 
by either clicking the misrecognized marker 
or a marker you want to delete with the left 
mouse button or by dragging the cursor while 
holding down the left mouse button.The 
selected markers are displayed in red. When 
you click the selected markers using the left 
mouse button again, the markers become 
unselected. After selecting a marker to delete, 
click the right mouse button to display the pop-
up menu and then select [Delete Selected 
Marker] to delete the selected marker.
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10 Rotate the work to a different angle, 
and adjust the scan position by 
monitoring.
Decide the positions for scanning by 
over lapping three or  more markers 
(preferably five or more markers) between 
the previous shot and the next shot.
In the same way as steps 2  to 6  , adjust 
the scan positions.

11 Click   [Scan] button.

The registered elements appear in the 3D 
window.
Obtain the necessary data from the work 
by repeating steps 3  to 6  .

Scan button

12 Scanning is completed as per 
settings.

The image scanned in the previous shot 
appears in the window for the already 
scanned element, and the imaged scanned 
this time appears in the preview window.
The name of the captured data appears in 
the element list.
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13 After rotating the work to a different 
angle, adjust the scan position by 
monitoring.
In the same way as steps 9  to 13  , 
scan necessary data by repeatedly 
adjusting the scan position, scanning, 
and registration.

Point
Saving Reference Markers 
Click the [Save ref.] button in the Scan 
Sett ings dialog box. The reference 
markers are saved as a rmk file. Also, 
you can resume interrupted operations 
by clicking the [Open ref.] button to recall 
saved reference markers (rmk file).
Function to read out reference marker
Registration can be started again with the 
interrupted "markers" by reading out the 
saved rmk file. 
Also, since the 3D coordinates of each 
marker  aff ixed to the work can be 
determined, registration can be performed 
with "markers (fixed)".
The files that can be read out are rmk file 
and txt file. The rmk file has an original 
format. 
For details of txt file, see Reference Manual, 
P.90.
Creating New Reference Markers 
To delete all captured reference markers, 
as might the case when ready to scan a 
new work, click the [New ref.] button. All 
reference markers are deleted.

 S
av

in
g

14 Select [Save As] from the [File] 
menu.

Save the registered data.

(Condition where all the reference markers are deleted)
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7. Editing Scanned Data
7.1 Deleting Unnecessary Points
When you want to erase unnecessary data taken with the measurement, such as a background, you can 
select the section you want to erase or select it by inverting and delete it. To use these commands, you must 
open the [Edit] tab and at least one element must be registered.
As the method of selecting points, there are rectangle selection, Bezier selection, point selection, element 
boundary, selecting / unselecting, and inversion of points.
Only the points of selected elements in the element list are selected. However, if front point selection is ON, 
only points facing to the front are selected. And, both points of elements selected in the element list and points 
of unselected elements appear in the 3D view.

 Buttons for selecting / deleting points  To select/unselect groups of points, select [Select] from 
the [Edit] menu .

 To delete a group of points,  select [Delete] from [Edit] 
menu and then click either [Select Points] or [Select 
Elements].

Functions of the edit buttons

Rectangle select
Selects or unselects the points enclosed in 
a rectangle drawn by mouse operation.

Rectangle select 
Draws a rectangular area for 
selecting/unselecting points.

Bezier select 
Draws a Bezier curve for selecting/
unselecting points.

Point selection invert 
Inverts points between selected/
unselected.

Element boundary point select  
Selects only boundary points of 
elements.

Front point select 
Enables selecting points having the 
normal facing towards the camera.

Point delete 
Deletes the paired points.
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Element boundary point select
Selects the elements’ boundary (the 
boundary of the holes) automatically. With 
merged elements, the boundary of all the 
merged elements is selected.

Front point select
Selects the points facing towards the front 
of the current view of elements selected by 
rectangle selection or Bezier selection.

When the front 
point select button 
is highlighted, the 
function is active.

When deleting 
by Points, only 
surfaces with 
holes facing the 
front are deleted.

Point delete
Deletes the points that have been selected 
in the elements.

Bezier select
Selects or unselects the points enclosed 
by a Bezier curve drawn by mouse 
operation.

Point selection inversion
Inverts the selected / unselected status of 
the selected element points.
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7.2 Registration
This command is for positioning two or more elements in the element list. When executed, the selected 
element of the highest position serves as the reference for positioning the other elements. A dialog box 
appears with the results.
*Before merging elements by “7.4 Merging”, perform the registration.

 Select the desired elements from the element list.

 Click the element registration button.
Registration calculations begin. Once ended, a 
dialog box appears with the calculated Mean Error 
and Standard Deviation. To finish registration, click 
[Quit].

Mean Error and Standard Deviation
The mean error and standard deviation are reference values for registration results. Both are indicated 
in units of mm: mean error giving the average amount of error in the registration result and the standard 
deviation giving the variance of that error. Normally, as the values approach “0”, the closer the position 
matches the reference position.

Registration with marker information
If there are markers, registration can be performed with the marker 
information.
If registration is performed, the dialog at the left is displayed. To perform 
registration with the marker information, select [Yes]. If registration is 
performed with the marker information, each position is adjusted finely 
so that the shapes of the other parts will match while maintaining the 
congruency of the marker positions. Fine adjustment to the position can 
be made after registration is performed with the markers.
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7.3 Edit marker holes
When registration is performed by using a marker, editing is done for data around the marker which is pasted 
to the scanned object. In case scanned data (rvm, rgv file) and a reference marker (rmk file) are read out, 
editing can be done for data around the marker in the same way.
The function to keep points on the marker selected (selection of points on the marker) and the function to 
replace point groups around the marker with the shape calculated based on point groups around the marker 
can be executed.

 Click the edit button of the marker holes.
Select functions to be executed.
• By clicking [Yes], the selected function is executed.
• By clicking [No], the dialog is closed without 

executing the selected function.

 Selects elements which are to be edited for point groups of the marker holes.

Point
Selection of points on markers
Select all the points near the reference marker in the form of a 
discus. By deleting in the [Edit Mode] screen, a hole is formed.

 Supplement
After executing selection of points on the marker, points which 
were selected before the execution become non-selected. 
Only the points on the marker are selected. This operation can 
return the condition to the original state by cancelling.

Marker hole-filling
Replace points on the reference marker with the shape 
calculated based on the point around the reference marker. 
By means of [Hole-filling level], the acceptance level of a hole-
filling result can be set. By increasing the number, markers 
pasted to a round surface can be hole-filled.

 Supplement
When the number of selected elements around a reference 
marker is few, the points around the reference marker are 
selected. Selected points before the execution are not 
selected, and only the points which failed to perform hole-
filling are selected. This operation can return to the original 
state by cancelling.
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7.4 Merging
Select 2 or more elements to interpolate from the element list. When merged, the selected individual elements 
are deleted and only the merged element remains.

 Click the merge button.
Displays the dialog to save data and the dialog to proceed 
with the merging process, and the calculation begins when 
merging proceeds. 
Once completed, the individual elements that existed prior 
to merging are deleted from the element list, whereas the 
newly merged element appears in the element list. 

 Select registered elements from the element list.

 A single merged element is created.
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8. Saving Data and Exporting
8.1 Saving Data
When you select [Save], the open file is saved. Files can be saved in either of two formats, rvm or rgv, but the 
Save function can save data only in rvm format.
* When saving an "rgv" file with its current name, you must use [Save As] and specify the current name.

 Buttons to be executed from the editing window  To save a file, select [Save] or [Save As] in the [File] menu.

8.2 Setting Automatic Save Feature
It is recommended to save scanned and edited data frequently in anticipation of possible trouble. In consideration that you 
may want to restore data to its original state, it is also recommended to create backup files by saving the data under a 
separate file name or creating a duplicate file. In anticipation of possible trouble, you can set the automatic save feature.

 From the [Preferences] dialog box, select the [FILE] tab.

File Formats
RANGE VIEWER uses two file formats: rvm that groups all elements into a single file and rgv that 
creates one file for each element.

rvm format
Multiple elements are grouped into a single file.

rgv format
Each element has its own file.

rgv

rgv

rgv

Open button
Open the file.

Save button
Save the file.

Set whether or not to use the automatic save feature. Placing a 
checkmark in this checkbox enables automatic saving at the set 
time interval. However, automatic saving is performed only when 
there has been a change to the element. The file format is rvm.
The time interval for automatic saving can be set from 1 minute to 
60 minutes.

rvm



8. Saving Data and Exporting

42

8.3 Exporting
Scanning data and editing data can be exported to other 3D point processing software from other 
manufacturers. The 3D data can be exported via saving files or using IPC function sent directly to other 
applications.

 The buttons to be executed from the edit window  To export, select [Export] in the [File] menu.

Exporting with the IPC function (File Transfer)
Exporting with [File] – [Export] – [Application Software *] uses the IPC function.
Compared to exporting through a file (Export), the file transfer export method is simpler and faster because it 
eliminates the need to save the file or read in the file.
Confirm that the external software supports the IPC function.
* "Application Software" is enabled when preparations are complete on the external software side for receiving the 

export from RANGE VIEWER, and shows the name set by the external software.

STL Files
This file format is specifically for SLA CAD software by 3D Systems. It is supported by a wide range of analysis 
software and allows 3D data to be directly input in STL format for use with prototyping machines. The recorded 3D 
modeling data forms a polygon of the surface normal vectors and coordinates for three vertexes of a triangle. STL 
files can be ASCII or binary format, but RANGE VIEWER exports only the binary format.
Merged data is exported to a single STL file without connections between the merged elements.

ASC Files
Exported ASC (ASCII) files contain 3D point data without normal information.

Export button
Exports elements to an application 
software.

'Application' sub menu of Export will be activated when the 
third-party software is ready to import the 3D data from 
RANGE VIEWER. At this time, 'Application' menu name will 
be changed to the name that set by the third-party software.
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9. Viewing 3D images
9.1 Changing Viewpoint and Zoom of Works
Previews and scanned data of works appear as 3D images. You can view enlarged 3D images and merged 
images by changing the viewpoint using the menu buttons. Select either one of the [Viewpoint rotate], [Viewpoint 
move], [Zoom], [Zoom selected area], and [Fit to window] buttons. The selected menu button is highlighted. 
You can also carry out the same operation by selecting [Rotation/Zoom] from the [Display] menu.  A check is 
marked on the selected menu item.

Functions of the menu buttons

 
Viewpoint rotate 
You can rotate the viewpoint by pressing and 
holding the left mouse button and dragging the 
pointer.
Left-clicking on a point above the scan data while 
holding down the [Ctrl] key will switch the center of 
rotation to the position of the point. 

While you are pressing and holding the mouse 
center button (wheel), the icon becomes  and 
you can move the viewpoint by dragging the 
pointer.

By rotating the mouse center button (wheel), you 
can zoom in / zoom out the display range.

 
Viewpoint move
You can move the viewpoint by pressing and 
holding the left mouse button, and dragging the 
pointer.

Menu button

The selected button is highlighted.

[View] menu

3D image is mainly displayed by mouse operation.

Center button 
(Wheel)

Right button

Left button
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 The mouse right button also has functions. (Clicking the right mouse button displays a popup menu)

Fit to window  Resizes the whole 3D data to fit the window size.
Points / Shades Switches to the view that is not selected at present.
Switches the viewpoint. Display 3D data by switching the orientation from [Front], [Back], [Top], [Bottom], [Right], and [Left].

 
Zoom
You can zoom in/zoom out the display range by 
pressing and holding the left mouse button, and 
dragging the pointer up/down in the screen.

  
Zoom selected area
While pressing and holding the left mouse button, 
the display area can be drawn as a rectangle.

When you release the left mouse button, the 
display area is set as the drawn rectangle.

Display the popup menu for Zoom in / Zoom out /  
Cancel by clicking the right mouse button, and 
select one of the commands.

  
Fit to window
When you press and hold down the button, the 
display area is automatically zoomed in/out to 
display all the elements.

  
Show points
Displays the points in 3D data.
Because the shaded 3D parts are not calculated 
and displayed, the points view enables faster 
drawing than the shaded points view.
When you perform editing operations such as 
deleting unnecessary points, the points view 
enables faster processing.
The size of the points can be set from 1 to 10.

 
Show shaded points
3D data is displayed in shades. Shadows are 
calculated from the position of the light source and 
reflected light to display three-dimensional views.
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9.2 Changing 3D image Display Mode
To make it easier to edit elements before mergers, you can set the color of selected elements, the transparency of the last 
scanned element, and the color of unselected elements.

Operating procedure

1 You can set the display mode by selecting   
[Preferences] from the [File] menu and using 
the [DISPLAY] tab in the [Preferences] dialog 
box.

2 You can set the selected color for each 
element.
Select the element from the element list, and then 
select [Element Information] from the popup menu 
that opens by clicking the right mouse button. Or, 
select [Element Information] from the [View] menu.

Example: OrangeExample: Green

A
B

C
D

E
F

G

H
I

J

K
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The color of the selected elements is set to “green” by [Preferences] “ B  ”: the shaded color of the selected element. 
However, because the color of the element in the selection of [Element Information] “ K  ” has been set to “ orange”, the 
individual setting of [Element Information] is prioritized, and the selected elements are displayed in “orange”.

C  Displayed in the shaded 
color of unselected 
elements.

E  Color of selected points
F  Color of unselected points

D  Size of shaded points

H  3D view background color

J  Show coordinate 
axis (three places)

I   Show 3D view 
title (two places)

B  Displays selected 
elements in selected 
colors, but others are in 
un-selected colors.
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10. Scanning Works Accurately
WARNING
Do not look directly into the laser emission window.
Keep lenses, objects with mirror-like surfaces and optical elements out of the optical path. These 
objects can focus the laser beam, resulting in damage to eyes, fire and burns. Also, to prevent 
inadvertent accidents, situate works in front of a wall or other structure that shields the laser beam.

10.1 Calibration
Calibration reduces errors caused by environmental changes 
or changes over time. 
Calibration should be performed if ambient temperature has 
changed since the last time the instrument was calibrated. 
If temperature changes ±1.5˚C from the time of calibration, 
RANGE VIEWER displays a warning to prompt you to perform calibration.

When scanning is executed while a warning mark is ON, a warning dialog is displayed before starting to scan.
To avoid the display of the warning dialog, check when warming up is complete in the condition where no temperature 
change takes place in the environment at a certain temperature. Make sure to scan in the same temperature environment.
Calibration is unnecessary when lenses are interchanged. (Calibration is required after interchanging lenses if temperature 
has changed since the last time the instrument was calibrated with the newly mounted lens.)

Before Calibration (Calibration Set)
The calibration set includes the following.

Calibration sheet Calibration chart Calibration stand

1280 x 430 (mm) plastic sheet. Sufficient 
space to spread out the calibration chart 
is required.

Do not touch the front side of the chart 
with bare hands.

Supports the RANGE7/5.

RANGE7/5 position

For calibration with WIDE lens

For calibration with TELE lens

The chart can be titled to three set angles 
by pulling the knob on the left face of the 
chart stand. The stand makes it easy 
to establish the angles shown in the 
RANGE7/5 Calibration Wizard.

How to use

•Calibration setup

*  The RANGE7/5 can be 
calibrated on its scanning 
stand without using 
the calibration stand.
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Enough space is needed to spread out the 
sheet.
1280 x 430 mm

Set the calibration chart in the position marked 
on the sheet for the lens being used.

Do not touch the front side of the chart with 
bare hands. If dirty, wipe the chart clean with 
a dry soft piece of cloth.

Scanning is done seven times for calibration. 
Position and angle the calibration chart as 
indicated in the Calibration Wizard.

Calibration is easy to understand and perform 
with the Calibration Wizard. For details, see 
“5.1 Calibration” on p. 72 of the Reference 
Manual.

10.2 Equipment for Calibration and Usage

RANGE7/5

Calibration sheet

Calibration chart

Calibration stand
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Calibration with the RANGE7/5 on the Scanning 
Stand
Adjust the stand in the height direction from the 
adjustable legs. In the horizontal direction, either fine-
adjust the stand’s position or reposition the calibration 
chart.

Using the Stand Pan Head
Adjust the stand in the height direction from the tilt lever, 
and lock in place.
In the horizontal direction, either fine-adjust the stand’s 
position or reposition the calibration chart.

Monitor window

Red boxes

Outside rows of dots 

Swing angle 
adjusting lever

Note: As long as the outside rows of 
dots fit in the two red boxes, problems 
are not caused by the calibration 
chart being slightly displaced from 
the picture on the calibration sheet.

Point

While watching the monitor window, fine-
position the RANGE7/5 and calibration 
chart so that the outside rows of dots of the 
chart fit in the two red boxes. Make sure the 
outside dots do not cross the outside red 
frames.

Point

Also be careful about the color of the dots displayed on the "Monitor Screen".
The colors of the dots show whether or not the distance between the RANGE7/5 main unit and the 
calibration chart is correct.
Be aware that if the distance is not correct, the difference in distance may make correct calibration 
impossible.

(Example of good results)
If the color is the same orange as that shown in the 
"Sample" on the right side, the distance is correct.

(Example of poor results)
If the dots on the "Monitor Screen" are red, this shows 
that the RANGE7/5 is too close to the calibration chart, 
so move the RANGE7/5 main unit 3 to 5 mm farther 
away from the calibration chart.

If the dots are yellow, this shows that the RANGE7/5 
is too far from the calibration chart, so move the 
RANGE7/5 main unit 3 to 5 mm closer to the calibration 
chart.

Point

If a dot is missing from the measurement 
data displayed on the "Monitor Screen" 
check screen, correct calibration is not 
possible.

(Example of poor results)

Notched dots

(Example of good results)
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11. Help
11.1 Tool Tips
Tool tips are a function that displays a description of the operation which would be performed by a button that 
you bring the mouse cursor close to (for example a menu button or edit button).

Operating Procedure

1 Select [Tool tips] from the [Help] menu.

A checkmark appears next to [Tool tips] and the 
tool tips feature is activated. To hide the tool tips, 
select [Help] - [Tool tips] from the menu bar again. 
This removes the checkmark.

Example tool tip display
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11.2 Instruction Manual
This command calls pdf files of the RANGE VIEWER user's guide (this manual) and reference manual.

Operating Procedure

1 Select either one of the instruction manuals 
from the [Instruction Manuals] from the 
[Help] menu. 

The table of contents pages for the respective 
manuals are displayed in PDF format.

11.3 About RANGE VIEWER
This command displays the version of the installed RANGE VIEWER as well as the version of the firmware 
used in the connected sensor. 

Operating Procedure

1 Select [About RANGE VIEWER] from the 
[Help] menu.

The same opening window seen when the 
software is started up appears.
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Show points button ·······························  10, 12, 44
Show shaded area button ·····················  10, 12, 44
Size of shaded points ·······································   46
size of the work ················································   14
Spot AF ····························································   17
Spot AF button ··················································  11
Standard Deviation ··········································   38
Startup ·······························································   8
Status bar ··················································   10, 12
status bar ···························································   8
STL Files ··························································   42

T
the shaded color of unselected elements ·········   46
Title bar ······················································   10, 12
Tool Tips ···························································   50
TXT ··································································   18
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U
Undo button ·····················································   13

Z
Zoom button ··········································  10, 12, 44
Zoom selected area button ···················  10, 12, 44
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